
  ProgressBook StudentInformation Advanced Ad-Hoc Reporting 
 

 

 

 

 

 

 

 

 

 

ProgressBook StudentInformation 
Advanced Ad-Hoc Reporting 

 

 

 

 

 

 

 

 

 

 

 





  ProgressBook StudentInformation Advanced Ad-Hoc Reporting 
 

 

Table of Contents 
1 Standard Report Wizard .................................................................................................................................................. 1 

1.1 Name Tab ................................................................................................................................................................ 1 

1.2 Categories Tab ........................................................................................................................................................ 2 

1.3 Sorts Tab ................................................................................................................................................................. 2 

1.4 Filters Tab ................................................................................................................................................................ 3 

1.5 Layout Tab ............................................................................................................................................................... 3 

1.6 Editing Standard Reports ........................................................................................................................................ 7 

1.7 Referencing a Cell ................................................................................................................................................. 16 

2 Advanced Filtering ........................................................................................................................................................ 17 

3 Formulas........................................................................................................................................................................ 19 

4 Charts ............................................................................................................................................................................ 32 

4.1 Type ....................................................................................................................................................................... 32 

4.2 Data ....................................................................................................................................................................... 34 

5 Gauges ........................................................................................................................................................................... 39 

5.1 Appearance ........................................................................................................................................................... 39 

5.2 Data ....................................................................................................................................................................... 40 

6 Training Workshop Demo ............................................................................................................................................. 48 

7 New CrossTab Wizard ................................................................................................................................................... 41 

7.1 Name Tab .............................................................................................................................................................. 41 

7.2 Categories Tab ...................................................................................................................................................... 41 

7.3 Filters Tab .............................................................................................................................................................. 42 

7.4 Layout Tab ............................................................................................................................................................. 43 

7.5 Row Headers ......................................................................................................................................................... 43 

7.6 Column Headers .................................................................................................................................................... 44 

7.7 CrossTab Options .................................................................................................................................................. 46 

 

 



Standard Report Wizard 

1  ProgressBook StudentInformation Advanced Ad-Hoc Reporting 
 

1 STANDARD REPORT WIZARD 

The Standard Report Wizard is an interactive tool that walks you through the process of creating a new standard report. 

All the selections made in the Standard Report Wizard can be modified in the Report Designer after the report is 

created. 

To navigate the wizard, either click the desired tab or use the buttons at the bottom. 

 

 

  

The Report Wizard has five subtabs. The Name and Categories tabs must be completed while the other tabs are 

optional.  

1.1 NAME TAB 
In the Name tab, enter a report name and click on the Folder to which you want to save the report. 

The report name can be up to 255 characters. Avoid special characters such as ? / \ * “ “ < >.  

The report’s description displays at the bottom of the Main Menu when it is selected. The description text is also used 

when searching for a report.  

Note: You cannot create a report inside a folder that is read-only (  ).  
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1.2 CATEGORIES TAB 
In the Categories tab, select the Data Categories that you would like to have access to on the report. It is important to 

understand two terms: Data Category and Data Field.  

Data Category – A Data Category is a data object that has several attributes. For example, Students is a category; each 

student has an ID, a major, an advisor etc.  

Data Field – A Data Field is a single attribute within a category. For example, Students.ID is the numeric value that 

identifies a specific student.   

 

• To add a Data Category, either drag and drop it to the Category Name Column, use the Add button, or double-

click it.  

• To see what Data Fields are in a Data Category, click the information button ( ).  

• Select the Suppress Duplicate check box to suppress duplicate information from displaying on the report. 

• To remove a Data Category, click the delete button ( ). 

1.3 SORTS TAB 
In the Sorts tab, you can specify which Data Fields are used to determine the order of data on the report.  
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• To sort by a Data Field, either drag and drop it to the Sort By Column, use the Add button, or double-click it.  

• Utilize the  or Add Formula button to sort by a formula. 

• Use the  (up/down) and  (up/down) arrows to indicate the sort priority.  

• You can sort each Data Field in ascending (A- Z) or descending (Z-A) order. 

• To remove a sort, click the delete button ( ). 

1.4 FILTERS TAB 
In the Filters Tab, you can create statements that are used to filter the data when you run the report.  

 

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or 

alphanumeric.  

• To filter a Data Field, either drag and drop it to the Filter By column, use the Add button, or double-click it.  

• Use the  (up/down) and  (up/down) arrows to indicate the sort priority.  

• To remove a sort, click the delete button ( ). 

• Set the operator (Equal To, Less Than, One of, etc.) by selecting it from the operator drop-down list. 

• Set the filter value by either entering it manually or selecting a value from the drop-down list. If the Data Field is 

a date, the calendar and function buttons can be used to select a value.  

• Select AND With Next Filter to require that the selected filter and the one below it are both true. Select OR 

With Next Filter to require that either be true. 

• Select the Group With Next Filter check box to indicate the precedence of the filters. 

• Select the Prompt for Value check box to allow the filter to be modified at the time the report is executed. 

1.5 LAYOUT TAB 
In the Layout tab, you can select the Data Fields that display on the report. For each Data Field chosen, the report 

automatically creates a column header and places the Data Field in the detail section. Additionally, sub-totals, grand 

totals, and a page header/footer can be created.  
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1.5.1 Display Data 

• To place a Data Field on the report, either drag and drop it to the Data Field column, use the Add button, or 

double-click it.  

• Use the  (up/down) and  (up/down) arrows to indicate the order the Data Fields should display on the 

report. The Data Field at the top displays on the report as the left most column. 

• The Summary Function column is used to make sub-totals and grand totals. See Sub-Totals and Grand Totals for 

more information. 

• To remove a sort, click the delete button ( ). 

• Using the Summarize By grid, you can display sub-totals, grand totals, or headers for each unique value of a 

Data Field.  

1.5.2 Sub-Totals and Grand Totals 

• To display sub-totals, select the corresponding check box of the category you want sub-totals for in the 

Summarize By grid. Then, for each Data Field you want totaled, select a Summary Function (see below). 

• To display grand totals, select the Grand Total check box. Then, for each Data Field you want totaled, select a 

Summary Function (see below). 

          Summary Functions: 

o Sum: Totals all of the data in the Data Field. 

o Count: Returns the number of rows in the Data Field. 

o Average: Takes the mean of the data in the Data Field. 

o Minimum: Displays the lowest value in the Data Field. 

o Maximum: Displays the highest value in the Data Field.  

https://si.tccsa.net/Exago/NetHelp/Documents/subtotalsandgrandtotals.htm
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1.5.3 Data Headers 

A check box displays in the Summarize By grid for each Data Category in the Sorts tab. To display a header for each 

value of a Data Field, click on the associated Data Category in the Summarize By grid, and a Header Menu displays.  

• To include a Header, select the Include Header at the beginning check box. In order to select the text that 

displays as the header value, use the Header drop-down list to select a Data Field or use the Formula Editor 

Button ( ) to create a formula. 

• Select a specific field from the Summarize by each unique drop-down list to specify if the header should repeat 

based on a specific field or all the keys of a Category.  

• Select the Include Total at the end check box to create a sub-total for this Category. 

 

1.5.4 Page Header 

To display information on the top of each page, select the Page Header check box below the Summarize By grid. A Page 

Header Menu displays.  

 

• Select the Include Title at the top of every page check box to display the name of the report on each page. If an 

image is also included, use the Position drop-down list to set where the title should appear and the number of 

columns it should span. 

• Click the Change Image button to upload an image to display at the top of each page. If a title is also included, 

use the Position drop-down list to set where the image should appear and the number of columns it should 

span. 
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1.5.5 Footers 

To display information on the bottom of each page, select the Page Footer check box below the Summarize By grid. A 

Page Footer Menu displays.  

 

• Select the Include page number at the bottom of every page check box to display the page number on each 

page. If an image is also included, use the Position drop-down list to set where the page number should display 

and the number of columns it should span. 

• Click the Change Image button to upload an image to display at the bottom of each page. If the page number is 

also included, use the Position drop-down list to set where the image should display and the number of columns 

it should span. 

 

1.5.6 Preview 

At the bottom of the Layout tab, a preview displays how the report will appear based on the fields that have been 

added.  You can increase the size of the preview or hide it all together by dragging.  
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1.6 EDITING STANDARD REPORTS  

1.6.1 Report Designer Overview 

The Report Designer can be used to add data, charts, formulas, sorts, filters, and many other features to a report.  The 

Report Designer has three parts; the Data Menu, Toolbar, and Design Grid. 

 

1.6.2 Data Menu 

The left column of the Report Designer screen contains the Data Menu. Through this menu, users can add or swap Data 

Fields from various categories selected during the Report Design Wizard.  

1.6.3 Toolbar 

Using the toolbar, users can: 

• Rename the report. 

• Add, modify, or remove sorts and filters. 

• Format cells’ font, font size, alignment, color, and borders. 
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• Use the Formula Editor to create complex functions. 

• Insert charts and images. 

• Link reports, allowing users to drilldown for more detail. 

• Save the report. 

• Execute the report as HTML, Excel, CVS, RTF, or PDF.  

• Give a report access to new Data Categories or remove Data Categories from the report. 

 

a. Report Options – Provides several advanced feature options for the report that is being edited. 

b. Save – Click to save the report. 

c. Create a new report – Click to start a new Standard Report Wizard. 

d. Format Cells – Provides a pop up window for additional formatting of cells. A cell or series of cells must be 

highlighted for the formatting to take effect. Formatting options include: formatting of data values, border 

outline of cells, and conditional formatting. 

e. Format Paintbrush - Cell formatting can be copied using the Format Paintbrush. Select the format you want to 

copy, click the format paintbrush button, then click the cell you want to apply the formatting to.  

f. Font – You can change the font of cells from default (Arial) to another available font type. 

g. Align Top, Align Center, & Align Bottom – Click to align text within cells vertically according to the option 

selected.  

h. Merge Cells – Allows multiple cells to be highlighted and merged. 

i. Split Cells – Allows merged cells to be re-split back to original column span.  

j. AutoSum – To quickly get a total on a Data Field, place the field in a Report or Group Footer and click the 

Autosum button. 

k. Insert Image in Active Cell  

l. Formula Editor  

m. Execute Selected Report – Executes the report in the format chosen. A drop-down list is available if more than 

one format is allowed. Format options can include PDF, HTML, CSV, XLS, and RTF. 

n. Undo – Click this or press CTRL + Z to undo any action on a report. 

o. Redo – Click this or press CTRL + Y to recomplete an undone action. 

p. B, I and U – Modifies the font to be bold, italicized and/or underlined, respectively. 

q. Foreground Color – Changes the font color. 

r. Background Color – Changes the cell color. 

s. Font Size – Changes size of font for the cell selected. 

t. Left, Center, Right, Justify – Changes Horizontal Cell Alignment. 

u. Wrap Text – Wraps the text within the selected cell(s). 

v. Suppress Duplicate Values - You can suppress duplicate values of a Data Object from displaying. Select the cell 

and click the Suppress Duplicate Values button. As an example, the two reports below are identical, except the 

right image has suppressed duplicates of the customer column. 

Note: This is rarely used within StudentInformation as Data Objects are designed to have no duplication.  

Note: Charts should only be placed into a Group Footer or Report Footer section.  
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w. Linked Report - The ability to create drill downs can be added by linking reports. Linked reports are only 

available for HTML output.  

x. Cross Tab Wizard – Crosstabs allow the report to expand both horizontally and vertically based on data values 

and displays summary information where each column and row meets. A CrossTab consists of three parts: Row 

Headers, Column Headers and Tabulation Data. Additional settings for CrossTabs can be found in the CrossTab 

Options Menu. See Section on the Cross Tab Wizard for more specific information.  

y. Chart Wizard – You may display a chart in a report to give a visual interpretation of the data. To insert a chart, 

select a cell and then click the Insert Chart button. The Chart Wizard appears. The Chart Wizard has four tabs: 

Type, Data, Appearance, and Size and Preview.   

z. Gauge Wizard – You may display a gauge in a report to give a visual interpretation of the data. To insert a gauge, 

select a cell and then click the Insert Gauge button. The Wizard appears with two tabs: Appearance and Data. 

aa. Run Report – Displays report in Report Viewer mode. 

Note: For the section a CrossTab is in, all the cells below and to the right of a CrossTab must be empty.  

1.6.3.1 Report Options 

Report options can be accessed via the Standard Report Screen on the main toolbar. It is the icon 

( ) located on the far left of the toolbar. The following report options can be maintained 

through this icon ( ) 

1. Rename – Rename the report.  

2. Description – Add or Modify the description of the report. 

3. Categories – Add or Remove Categories from the report 

WARNING: OPENING THIS OPTION REMOVES ANY JOINS CREATED FOR THE REPORT. JOINS 

MUST BE RECREATED AFTER CLOSING THE CATEGORIES WINDOW. 

4. Sorts – Add, Modify, or Remove Sorting options for the report.  

5. Filters – Add, Modify, or Remove Filtering options for the report. 

6. Options – Modify General, Report Viewer and Custom options  

a. General – Allows users to change general Report execution options. 
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b. Report Viewer – These options are used to affect how reports are viewed when a report runs in HTML 

Mode.  

 

c. Custom Options – This is where the ‘Is_Vendor_Extract’ checkbox is located so Reports can be enabled 

for FTP. See Section 6.4 for further details on FTP.  

 

7. Template – Not utilized at this time. 

8. Advanced – Provides Advanced reporting options not covered in other menu items.  

a. Joins – See subsequent section Joins for further information regarding this option. 

1.6.3.2 Joins 

When utilizing more than one category, joins between the categories are necessary. To access the Joins screen, the 

Standard or Cross tab report must be in Edit Mode.  

Helpful Hint: For column joining information, refer to the View Information and Report List document found within 

your StudentInformation documentation site under the Helpful Hints section.  

From the toolbar, click on the Report Options Icon ( ). Then, choose Advanced -> Joins.  
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A new window displays so you can create the joins between two or more categories. Click +Add at the bottom right of 

the screen.  

 

Another window displays, and on the left, a drop-down list of categories are available along with a list within each 

category of column field names available.  Select the first category to be joined, and move columns over to create your 

unique matches between the categories. Then, select the second category to be joined, and move the matching column 

field names over. You can use as many unique fields as necessary to join the two categories together. 
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Note: The order of the column fields in the top and bottom sections of the join screen matter! If data within those 

columns do not match, you run the risk of receiving the ‘No Data Qualified’ report error when you run the report.  

If there are more than two categories to be joined together, you must create additional joins using the Add button and 

following the process above until all categories are joined together as necessary.  

 

1.6.4 Design Grid 

In the design grid you can: 

• Add and delete rows, columns, and sections.  

• Enter data fields, text, and formulas.  

• Drag and drop fields into different sections, rows, or columns.  

1.6.4.1 Sections 

Sections dictate how the data displays in a report. There are five types of sections: page, report, details, group, and 

repeating group.  

 Page Header &  Page Footer – The rows in the Page Header section display at the top of every page of a report. 

Typically, the Page Header section is used to designate column headers for a report. The rows in the Page Footer section 

display at the bottom of every page of a report. Typically, the Page Footer sections are used to display the page number, 

or confidentiality notices for a report. 

Note: Formulas and calculations should not be made in the Page Footer section.  

Note: If you are printing a report, remember that Excel output does not have pages. Page Headers display only once at 

the beginning of the report. Reports executed as HTML display Page Headers similarly unless ‘Simulate PDF’ is selected 

in the Options menu. 

file:///C:/Users/MelissaBauer/AppData/Roaming/Microsoft/Word/Documents/generaloptions.htm
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 Report Header &  Report Footer – The rows in the Report Header display at the beginning of a report. Typically, 

these rows display the title of a report, whereas the rows in the Report Footer display at the end of a report. Typically, 

the Report Footer displays grand totals and summary information for the report. 

 Detail – The Detail section is the main section of most reports. When the report is run, the Details section creates a 

row for each element in the Data Categories. For example, if the Detail section contains the Data Field Orders.OrderId, 

the report displays each Order Id in a separate row. 

 Group Header &  Group Footer – Group Headers/Footer sections require a sort on a Data Field. The rows in a 

Group Header section display above the Detail section for each unique value of the sorted Data Field. Typically, Group 

Header sections are used to display data as labels. For example, a report may contain a Group Header on 

Orders.OrderDate and display Orders.OrderId in the Detail section. The output displays each date with orders that 

occurred on that date below them. 

The rows in a Group Footer section displays below the Detail section for each unique value of the sorted Data Field. 

Typically, Group Footer sections are used to calculate subtotals. For example, a report may contain a Group Footer on 

Orders.OrderDate that displays the number of orders made on each date.  

Note: Group Header/Footer sections can also be set to display rows for each value of a formula instead of a Data Field. 

(e.g., The report may be sorted on the Data Field Orders.OrderDate but the report should show subtotals for each 

month. A Group Footer on the formula ‘=Month({Orders.OrderDate})’ displays rows containing subtotals for each 

month.) 

 Repeating Groups – Repeating Groups require a sort on a Data Field. Repeating Groups have their own header, 

details, and footer subsections. Repeating Groups should only be used when the data has multiple one-to-many 

relationships and each should be rendered completely before the other. (For example, each teacher can teach multiple 

classes and advise multiple students. For each teacher, you want to see all the classes they teach and then all the 

students they advise.) 

1.6.4.2 Using Sections 

Sections can be added, deleted, modified, moved, and assigned shading. 

Adding Sections 

1. Click anywhere in the Section column. 

2. Hover your cursor over Add Section, then select the type of section you would like to add. 

Deleting Sections 

1. In the Section column, click on the section you want to delete. 

2. Click Delete Section. 

Modify Sections (Group Header/Footers and Repeating Groups only) 

1. In the Section column, click on the section you want to modify. 

2. Click Modify Section. This brings up a Modify Group Section menu. 

3. Select the desired Data Field for the group to use from the drop-down list. 

4. Click OK. 
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Section Shading 

1. In the Section column, click the section that you want to shade. 

2. Click Section Shading. This brings up a menu. 

3. Click New to add a color to the shading.  

4. Click the color box to select a color or enter a hex value. 

5. Click OK. 

 

1.6.4.3 Columns & Rows 

Columns and rows of cells can be added, modified, or removed as described below. 

Columns 

• To select a group of columns, hold the <SHIFT> key and then click the beginning and ending column.  

• Non-contiguous columns can be selected by holding the <CTRL> key and clicking the desired columns. 

• A column can be resized by dragging its right edge horizontally. 

• Clicking on a column (or selected group) displays a menu where you can: 

o Insert a new column. 

o Delete the selected column. 

o Set the column’s width to be identical with the other selected columns. 

o Hide the selected column. 

o Set Column Info to make a label for the column and/or make it sortable on HTML reports 

 

Sorting by Columns on HTML 

While viewing reports run to HTML, a user can click the bar at the top of the report to sort by a column. For Express 

Reports, this is handled automatically but must be enabled for Standard and Crosstab Reports.  
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To make a column sortable in HTML 

• Click on the column and select Column Info… 

• Provide the column with a label that will display in the Interactive HTML Dock. 

• From the Sort drop-down list, select the Data Field to be used for sorting, or provide a formula by clicking the 

formula button ( ). 

Note: Html Column Sorts are applied AFTER any sorts defined in the Sorts Menu. 

 

Rows 

• To select a group of rows, hold the <SHIFT> key, then click the top and bottom row.  

• Non-contiguous rows can be selected by holding the <CTRL key> and clicking the desired rows. 

• A row can be resized by dragging its bottom edge vertically. 

• Clicking on a row (or selected group) displays a menu where you can: 

o Insert a new row. 

o Delete the selected row. 

o Set the row’s height to be automatically controlled. 

o Suppress the row from displaying on the report 

o Insert a page break. Note: Please see Using Page Breaks 
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Using Page Breaks 

For a Page Break to occur at the beginning of each element of a Data Field, place a page break on the top row of Group 

Header section for that Data Field. See Sections for more detail on Group Headers sections. 

 

1.7 REFERENCING A CELL 
To reference another cell’s value, enter the column name with a capital letter and the row number between square 

brackets (e.g., [A2]). A cell reference can be used in functions or alone in a cell following an ‘=’ sign. 

Note: Cell references update if rows or columns are added or deleted; however, dragging a cell 

does not update cell references. This may cause errors in your formulas. 
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2 ADVANCED FILTERING 

2.1.1 Standard Filters 

There are no limits to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or 

alphanumeric.  

• To filter a Data Field, either drag and drop it to the Filter By column, use the Add button, or double-click it.  

• Use the  (up/down) and  (up/down) arrows to indicate the sort priority.  

• To remove a sort, click the delete button ( ). 

• Set the operator (equal to, less than, one of, etc.) by selecting from the operator drop-down list. 

• Set the value to filter by either entering it manually or selecting a value from the drop-down list. If the Data Field 

is a date, the calendar and function buttons can be used to select a value.  

• Select Prompt for Value to let the filter be modified at the time the report is executed. 

• Select AND With Next Filter to require that the selected filter and the one below it are both true. Choose OR 

With Next Filter to require that either be true.  

• Select Group with next filter to indicate the precedence of the filters. 

 

2.1.2 Group (Min/Max) Filters 

Group filters are based on the minimum or maximum value in the Data Field. To modify group filters, click Switch to 

Group (MIN/MAX) filters. There are no limits to the number of group filters that can be defined.  

• To filter a Data Field’s minimum or maximum value, either drag and drop it to the Filter By column, use the Add 

button, or double-click it.  

• Select Minimum or Maximum from the drop-down list. 

• Use the  (up/down) and  (up/down) arrows to indicate the sort priority.  

• To remove a sort, click the delete button ( ). 
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3 FORMULAS 

Formulas let you do calculations, parse strings, insert images, and much more. Formulas are the composition of 

functions, parameters, Data Fields, and references to other cells.  

Functions must begin with an ‘=’ sign. You can use more than one function in each cell. Additionally, there are logical 

functions that allow for if/then/else conditional statements. Functions include date, financial, information, logical, 

mathematical, statistical, text, and data.  

Note: Function names are not case sensitive (aggSum is the same as AggSum). 

3.1.1 Using Formulas 

Formulas can either be entered in the Formula Editor or manually written into cells. 

3.1.2 Formula Editor 

1. Navigate to the Report Designer. 

2. Click inside the cell in which you want to insert the formula. 

3. Click the Formula Editor button ( ). 

 

4. Create the desired formula by selecting the desired functions and clicking Add, or by dragging and dropping into 

the Summary box.  

Note: When embedding functions begin with the outermost function and add them moving inward. (ex. To get 

=TRUNCATE(SQRT(162)), first add Truncate, then the square root function.) 

5. Click OK. 

file:///C:/Users/MelissaBauer/AppData/Roaming/Microsoft/Word/Documents/reportdesigner.htm
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3.1.3 Manual Formulas 

To manually add formulas: 

1. Navigate to the Report Designer. 

2. Double click in the desired cell. 

3. Enter the formula.  

4. Save the report. 

3.1.4 Types of Functions: 

• Aggregate Functions 

• Logical Functions 

• Date Functions 

• Financial Functions 

• Database and Data Type Functions 

• Arithmetic and Geometric Functions 

• String Functions 

• Formatting Functions 

• Other Functions 

3.1.5 Aggregate Functions 

Aggregate functions can be executed on non-numeric fields. 

AggAvg:  

Description Returns the average of the values in the field. 

Remark Only accepts Data Fields as input. 

Example Ex. aggAvg({OrderDetail.Quantity}) - returns the average quantity of sales orders. 

AggCount:  

Description Returns the number of unique entities in the Data Category. 

Remark The aggCount function uses the Data Category, not the Data Field. For example, the function 
“aggCount( {Officer.Salary} )” counts the number of Officers. You could replace 
“Officer.Salary” with any other field in the Officer Data Category and the function would still 
count the number of officers. 
 
Only accepts Data Fields as input. 

Example Ex. aggCount( {Orders.ProductPrice}) - returns the number of sales orders. 

AggDistinctCount:  

Description Returns the number of unique values in the Data Field. 

Remark Unlike aggCount, aggDistinctCount returns the number of unique values of the Data Field. 
 
Only accepts Data Fields as input. 

Example Ex. aggDistinctCount({OrderDetail.Quantity}) - returns the number distinct quantities in an 
order.  

AggMax:  

Description Returns the maximum value in the field. 

Remark Only accepts Data Fields as input. 

Example Ex. aggMax({OrderDetail.Discount}) - returns the largest discount. 

 

file:///C:/Users/MelissaBauer/AppData/Roaming/Microsoft/Word/Documents/reportdesigner.htm
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AggMin:  

Description Returns the minimum value in the field. 

Remark Only accepts Data Fields as input. 

Example Ex. aggMin({OrderDetail.Discount}) - returns the smallest discount. 

AggSum:  

Description Returns the sum of the values in the field. 

Remark Only accepts Data Fields as input. 

Example Ex. aggSum({OrderDetail.Quantity}) - returns the total quantity of units ordered. 

3.1.6 Logical Functions 

Logical functions can be used to handle conditional information. 

And:  

Description Returns TRUE if all its arguments are TRUE; returns FALSE if any argument is FALSE. 

Remark The arguments must evaluate to TRUE or FALSE.  
Note: The And function can take more than two arguments as input. 

Example Ex. AND(2+2=4, 4+0=4, 2+3=6) – returns FALSE. 

False:  

Description Returns the logical value FALSE. 

Remark You can also type the word FALSE directly onto the worksheet or into a formula; it is 
interpreted as the logical value FALSE. 

Example  

If:  

Description Takes three arguments as input. Returns the second argument if the first evaluates to TRUE. 
Otherwise returns the third argument. 

Remark The first input must evaluate to TRUE or FALSE. 

Example Ex. if({OrderDetail.Price}= 0,’FREE’,{OrderDetail.Price}) - returns FREE if the price is 0, 
otherwise it returns the price.  

Not:  

Description Reverses the value of its argument. 

Remark Argument should evaluate to TRUE or FALSE. 

Example Ex. Not(FALSE) - returns TRUE. 

Or:  

Description Returns TRUE if any argument is TRUE. 

Remark The arguments must evaluate to logical values such as TRUE or FALSE. 
Note: The Or function can take more than two arguments as input. 

Example Ex. OR(2+2=4, 4+0=8, 2+3=6) - returns TRUE. 

Switch:  

Description This functions should be used instead of placing if() function inside of if() functions. 
Takes any even number of inputs arguments. 

Remark The 1st argument is the test value to compare to. 
The 2nd argument is returned if none of the comparisons return true. 
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The 3rd, 5th, 7th… arguments are compared to the 1st argument. When the first match occurs, 
the following argument will be returned.  
For example, if argument 3 matches argument 1, then the 4th argument isreturned.  

Example Ex. Switch({Categories.CategoryName},”NOT FOUND,” “Beverages,” “Drink up!” 
“Condiments,” “Enhance,” “Confections,” “Sweet Tooth”) – returns a string based on the 
Category Name. 

True:  

Description Returns the logical value TRUE. 

Remark You can also type the word TRUE directly onto the worksheet or into a formula; it is 
interpreted as the logical value TRUE. 

Example  
 

3.1.7 Date Functions  

Date functions can be used to do calculations and formatting on Date values.  

Date:  

Description Creates a date value from three numeric values. 

Remark This function should be used to represent a date to other functions instead of representing a 
date as text. 

Example Ex. Date(2012,7,4) – returns the date July 4th , 2012. 

DateAdd:  

Description Returns the sum of a date and a quantity of time. 

Remark DateAdd takes three input arguments.  
A string representing the interval you want to add. The interval can be. "yyyy" (year), "y" 
(days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" (seconds), "ww" 
(weeks of year), or "q" (quarters).  
A real number representing how much time you want to add to the date.  
A DateValue. 

Example Ex. DateAdd(‘h’,1,Now()) – returns the date and time 1 hour from now. 

DateDiff:  

Description Returns the amount of time between two dates.  

Remark DateDiff takes three input arguments.  
A string representing the interval you want to add. The interval can be. "yyyy" (year), "y" 
(days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" (seconds), "ww" 
(weeks of year), or "q" (quarters).  
The first date value. 
The second date value. 

Example Ex. DateDiff(“yyyy”, date(1787,9,17), now())- returns the number of years since the signing of 
the United States’ Constitution 

DateValue:  

Description Converts a date represented as text (e.g. '30-jan-2008') to a date value.  

Remark Any time information in the Date_text is ignored. The ticks returned always represent a time-
of-day of Midnight (in the server's local time). 
If the year portion of Date_text is omitted, DATEVALUE uses the current year on the server. 
Use this function when comparing two dates. 
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Example Ex. DateValue(30-jun-2011) – returns the date object 6/30/2011. 
Ex. DateValue({Orders.OrderDate}) > DateValue(Today()) – compares the order date to today. 

Day:  

Description Returns the day portion of a date as a whole number. 

Remark Values returned by the YEAR, MONTH, and DAY functions are Gregorian Calendar values 
regardless of the display format for the supplied date value. 

Example Ex. Day({Appointment.Date}) - returns the day of the appointment. 

Day360:  

Description Returns the number of days between two dates based on a 360-day year.  

Remark Often used in accounting applications. 
Date360 takes three input arguments.  
The first date value. 
The second date value. 
Optional: True/False indicating to use European or American method of computation. If not 
included, the American method is used. 

Example Ex. Day360({Appointment.Date},today())- returns the number of days between today and the 
appointment date. 

GlobalDateFormat:  

Description Returns a DATE value whose format is based on the session format. 

Remark Only accepts data objects as input. 

Example Ex. GlobalDateFormat({Appointment.Date})- returns the date of the appointment based on 
the session format. 

GlobalDateTimeFormat:  

Description Returns a DATETIME value whose format is based on the session format. 

Remark Only accepts data objects as input. 

Example Ex. GlobalDateTimeFormat({Appointment.Date})- returns the date and time of the 
appointment based on the session format. 

Hour:  

Description Returns the hour of a time value ranging from 0 (12:00 AM) to 23 (11:00 PM).  

Remark Times may be entered as text strings within quotation marks or a date time value. 

Example Ex. Hour("2:50:05PM") – returns 14. 

Minute:  

Description Returns the Minute of a time value ranging from 0 to 59.  

Remark Times may be entered as text strings within quotation marks or a date time value. 

Example Ex. Minute("2:50:05PM") – returns 50. 

Month:  

Description Returns the month portion of a date as a whole number, ranging from 1 (January) to 12 
(December). 

Remark Values returned by the YEAR, MONTH, and DAY functions are Gregorian Calendar values 
regardless of the display format for the supplied date value. 

Example Ex. Month({Appointment.Date})- returns the month of the appointment. 
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Now:  

Description Returns today’s date and time (in local server time). 

Remark If embedding in other functions use Now(‘false’). 

Example Ex. Now() - returns the current date and time.  
Now(‘false’) returns the current date and time formatted MM/dd/yyyy hh:mm:ss. 

Second:  

Description Returns the seconds of a time value ranging from 0 to 59.  

Remark When a time omits seconds, 0 (zero) is assumed. 
Times may be entered as text strings within quotation marks or a date time value. 

Example Ex. Second("2:50:05PM") – returns 5. 

Time:  

Description Returns the number of ticks in a period of hours, minutes, and seconds. 

Remark This function should be used to represent a time to other functions instead of representing a 
time as text. 
Time takes three input arguments.  

• Hours 

• Minutes 

• Seconds 

Example Ex. Time(14,50,5) – returns 534050000000. 

TimeFormat1:  

Description Returns the time component of a DATETIME input formatted as 'hh:mm tt'. 

Remark This function should be used to represent a time to other functions instead of representing a 
time as text. 

Example Ex. Timeformat1({Appointment.Date}) – returns the appointment date in the format as 
‘hh:mm tt’. 

TimeValue:  

Description Convert a time represented in text (i.e., “HH-mm-ss”) into time values that can be passed to 
other functions. 

Remark Acceptable formats include "5:55 PM" and "17:55". A time separator is mandatory ("17:00" is 
acceptable, "1700" is not). 
If AM/PM is not present AM is assumed. When specifying AM or PM, do not use periods 
("A.M." or "P.M." return an error). 

Example Ex. TimeValue(Time(14,50,5))- returns the time object 14:50:05. 

Today:  

Description Returns today’s date with no time component. 

Remark If embedding in other functions, use Today(‘false’). 
See the Now() function to get today's date with its time component. 

Example Ex. Today()- returns the current date. 
Today(‘false’) returns the current date formatted as MM/dd/yyyy. 

Year:  

Description Returns the year portion of a date as a whole number, ranging from 1 to 9999. 

Example Ex. Year(today()) – returns 2011. 
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3.1.8 Arithmetic & Geometric Functions 

+, -, *, /:  

Description Basic mathematical functions. 

Abs:  

Description Returns the absolute value of a number. 

Remark  

Example Ex. Abs(-23.1) – returns 23.1. 

Acos:  

Description Returns the arccosine, or inverse cosine, of a number.  

Remark The input must be from -1 to 1. 
 
The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the 
result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function. 

Example Ex. Acos(-.231) – returns 1.80390168255052. 

Acosh:  

Description Returns the inverse hyperbolic cosine of the given number. 

Remark The input must be a real number greater than or equal to 1. 

Example Ex. Acosh(10) – returns 2.993223. 

Asin:  

Description Returns the arcsine of the given number in radians, in the range -Pi/2 to Pi/2. 

Remark The input is the sine of the angle you want and must be in the range from -1 to 1. 

Example Ex. Asin(-0.5) – returns 0.5236. 

Asinh:  

Description Returns the inverse hyperbolic sine of a number.  

Remark The input can be any real number. 
Note: asinh(sinh(n)) returns n.  

Example Ex. Asinh(-2.5) – returns -1.64723. 

Atan:  

Description Returns the arctangent, inverse tangent of a number.  

Remark The input can be any real number. 
Atan returns an angle given in radians in the range -Pi/2 to Pi/2. 

Example Ex. Atan(1) – returns 0.785398 (pi/4). 

Atan2:  

Description Returns the angle from the x-axis to a line containing the origin (0, 0) and a point with 
coordinates (x,y). 

Remark The input requires two values: the x and y coordinates.  
Note: If both x,y are 0 then Atan2 will return the error #Div/0! 
A negative result represents a clockwise angle.  

Example Ex. Atan2(1, 1) – returns 0.785398 (pi/4). 
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Atanh:  

Description Returns the inverse hyperbolic tangent of a number. 

Remark The input must be from -1 to 1. 
 
Note: Atanh(tanh(n)) returns n. 

Example Ex. Atanh(.76159416) – returns 1 (approximately). 

Ceiling:  

Description Returns the number rounded up, away from zero, to the nearest multiple of significance. 

Remark The input requires two values, the number to be rounded and the multiple of significance. 
Regardless of the sign of number, a value is rounded up when adjusted away from zero. 
Note: If the argument is non-numeric, then Ceiling returns the error #VALUE! 

Example Ex. Ceiling(4.42,.05) – returns 4.45. 

Cos:  

Description Returns the cosine of an angle in radians. 

Remark The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the 
result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function. 

Example Ex. Cos(1.047) – returns 0.500171. 

Cosh:  

Description Returns the hyperbolic cosine of a number. 

Example Ex. Cos(4) – returns 27.30823.  

Even:  

Description Returns a number rounded up to the nearest even integer. 

Remark Regardless of the sign of number, a value is rounded away from zero. 
Note: If the number is non-numeric, then EVEN returns the error #VALUE! 

Example Ex. Even(1.5) – returns 2.  

Exp:  

Description Returns e raised to the power of the input. 

Remark Exp is the inverse of Ln, the natural logarithm. 

Example Ex. Exp(1) – returns 2.718282 (the approximate value of e). 

Fixed:  

Description Returns the first argument rounded to the number of decimal places specified in the second 
argument. 

Remark Takes three input: 
1. The number you want to round. 
2. The number of digits to the right of the decimal to include. 
3. OPTIONAL: TRUE/FALSE whether to omit commas. The default is FALSE (includes commas 
as normal). 

Example Ex. Fixed(1234.5678, 2) – returns 1,234.56. 

Floor:  

Description Rounds the number down, toward zero, to the nearest multiple of significance. 

Remark The input requires two values: the number to be rounded and the multiple of significance. 
Regardless of the sign of number, a value is down toward zero. 
Note: If the argument is non-numeric, then Floor returns the error #VALUE! 
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Example Ex. Floor(2.6, .5) – returns 2.5. 

Int:  

Description Rounds a number down to the nearest integer. 

Remark The input must be a real number.  

Example Ex. Int(2.6) – returns 2. 

Ln:  

Description Returns the natural logarithm of a number. 

Remark LN is the inverse of the EXP function. 

Example Ex. Ln(86) – returns 4.454347. 

Log:  

Description Returns the logarithm of a number to the base you specify. 

Remark The first input is the number and the second is the base (if omitted base 10 used).  

Example Ex. Log(100) – returns 2. 

Log10:  

Description Returns the base 10 logarithm of a number. 

Remark  

Example Ex. Log10(86) – returns 1.934498451. 

Mod:  

Description Returns the remainder after first argument is divided by the second argument. 

Remark The second argument must not be 0.  

Example Ex. Mod(27,5) – returns 2. 

Odd:  

Description Returns a number rounded up to the nearest odd integer. 

Remark The input must be a real number. Odd always rounds away from zero.  

Example Ex. Mod(1.5) – returns 3. 

Pi:  

Description Returns the number 3.14159265358979, the mathematical constant pi, accurate to 15 digits. 

Remark  

Example Ex. Pi() – returns 3.14159265358979. 

Power:  

Description Returns the result of the first argument raised to the second argument. 

Remark The operator ^ may be used instead of this function 

Example Ex. Power(5,2) – returns 25. 

Product:  

Description Returns the product of the arguments. 

Remark The * symbol may be used in place of product. 
Arguments must be numbers, cell references, or text representations of numbers.  

Example Ex. Product(5,2) – returns 10. Also 5 * 2 - returns 10. 
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Quotient:  

Description Returns the integer portion of a division. 

Remark The / symbol may be used in place of product. 
This function discards the remainder of the division. 

Example Ex. Quotient(5,2) – returns 2. Also 5/2 – returns 2. 

Rand:  

Description Returns an evenly-distributed random number between 0 and 1 (inclusive). 

Remark To generate a random real number between a and b, use: RAND()*(b-a)+a. 

Example Ex. Rand() – returns a random number between 0 and 1. 

Round:  

Description Returns a rounded number. 

Remark Takes one or two input: 
1. The number to round. 
2. The number of decimal places desired. 

Example Ex. Round(5.236, 2) – returns 5.24 

RunningSum:  

Description Returns a running total of the input field. 

Remark Takes one or two input: 
1. The Data Field you want to sum. 
2. OPTIONAL: A Data Field or Category. The running sum resets to 0 whenever there is a new 
value for this Data Field or Category. 
Note: RunningSum should not be used with the AutoSum feature. 

Example Ex.  
1. RunningSum({Employees.Salary}) – returns running total of all the employee’s salary. 
2. RunningSum({Employees.Salary}, {Employees.Region}) – returns a running total of 
employee’s salary for each region. 
3. RunningSum({Employees.Salary}, {Company}) – returns a running total of employee’s salary 
for each Company. 

Sin:  

Description Returns the sine of the given angle. 

Remark The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the 
result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function. 

Example Ex. Sin(1.047) – returns .0865926611287823. 

Sinh:  

Description Returns the hyperbolic sine of a number. 

Remark  

Example Ex. Sinh(4) – returns 27.1899171971278. 

Sqrt:  

Description Returns the positive square root of the argument. 

Remark If the input is negative, Sqrt returns the error #NUM!. 

Example Ex. Sqrt(25) – returns 5. 
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Tan:  

Description Returns the tangent of the given angle. 

Remark The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the 
result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function. 

Example Ex. Tan(.785) – returns .99920. 

Tanh:  

Description Returns the hyperbolic tangent of a number. 

Remark  

Example Ex. Tanh(-2) – returns .96403. 

Truncate:  

Description Truncates a number to an integer by removing the fractional part of the number. 

Remark INT and TRUNC are different only when using negative numbers: TRUNC (-4.3) returns -4, but 
INT (-4.3) returns -5 because -5 is the lower number. 

Example Ex. Truncate(9.9) – returns 9. 

 

3.1.9 String Functions 

Concatenate:  

Description Joins several text strings into one text string. 

Remark The "&" operator can be used instead of CONCATENATE to join text items. 

Example Ex. Concatenate(“This,” “is,” “one string!” ) – returns This is one string! 

Left:  

Description Returns the first character(s) of a text string. 

Remark The first argument is the string you want to display. The second argument is number of 
characters you want. 

Example Ex. Left(“example”, 2 ) – returns ex. 

Len:  

Description Returns the number of characters in a text string. 

Example Ex. Len(“example” ) – returns 7. 

 

Lower:  

Description Converts all uppercase letters in a text string to lowercase. 

Example Ex. Lower(“EXAMPLE” ) – returns example. 

Mid:  

Description Returns a specific number of characters from a text string starting where you specify.  

Remark Mid takes three input arguments: 
1. The text string. 
2. The place you want to start. 
3. The number of characters you want to display. 

Example Ex. Mid(“example,” 2, 3) – returns xam. 
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NewLine:  

Description Begins a new line of text. 

Replace:  

Description Replaces part of a text string.  

Remark Replace takes four input arguments: 
1. The text string to partially replace. 
2. The place you want to start replacing. 
3. The number of characters to replace. 
4. The string you want to substitute.  

Example Ex. Replace("example,” 2, 3, "*") – returns e*ple. 

Right:  

Description Returns the last characters in a text string. 

Remark The first argument is the string you want to display. The second argument is number of 
characters you want. 

Example Ex. Right("example,” 2) – returns le. 

Trim:  

Description Removes all spaces from text except for single spaces between words. 

Example Ex. Trim("This sentence has weird spacing.", 2) – returns This sentence has weird spacing. 

Upper:  

Description Converts text to uppercase. 

Example Ex. Upper("example") – returns EXAMPLE. 

Value:  

Description Converts a text string that represents a number to a number. 

Example Ex. Value("$1,000") – returns 1000. 

 

3.1.10 Formatting Functions 

Bold:  

Description Applies the bold formatting to the input. 

Remark Can be used to bold part but not all of the text in a cell. 
An entire cell can be made bold using the bold button in the toolbar or ctrl + B. 

Example Ex. = ‘The second half of ‘& bold(‘this sentence is bold.’) – returns ‘The second half of this 
sentence is bold.’  

Italic:  

Description Applies the italic formatting to the input. 

Remark Can be used to italic part but not all of the text in a cell. 
An entire cell can be italicized using the italic button in the toolbar or ctrl + I. 

Example Ex. = ‘The second half of ‘&italic (‘this sentence is italic.’) – returns ‘The second half of this 
sentence is bold.’  

Underline:  

Description Applies the underline formatting to the input. 

Remark Can be used to underline part but not all of the text in a cell. 
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An entire cell can be underlined using the underline button in the toolbar or ctrl + U. 

Example Ex. = ‘The second half of ‘&underline (‘this sentence is underlined.’) – returns ‘The second half 
of this sentence is underlined.’  

3.1.11 Other Functions 

CellValue:  

Description Returns the value of the current cell. 

Remark This function is only used in Conditional Formatting. 

Example Suppose a cell of a report displays the price of products.  
Ex. CellValue()> 150 returns True if the price of the product is greater than 150. 

FilterValue:  

Description Returns the current value of a filter. 

Remark Takes three arguments. 
1. The index of the filter. 
2. The sub-index used for filters that contain multiple values (i.e. between or one of). 
3. (Optional) A true/false indicator if the value should be formatted following the user’s 
culture settings. This is used for numbers and dates.  
If there are no filters, the function returns an Index out of Range message. 
Indexes begin with 1. 

Example Suppose the filter summary is “Order Detail.UnitPrice > '3.6' and Products.ProductName is 
one of ('Boston Crab Meat,’ 'Tofu')”. 
Ex. FilterValue(2,2) returns Tofu. 

Hyperlink:  

Description Creates a hyperlink to an external website. 

Remark Takes two arguments. 
1. The URL of the website. 
2. (Optional) The text to display in the cell. 
If display text is omitted, the URL will display. 
Note: If PDF exports open in a tab within this application, then clicking the hyperlink may 
direct a user to leave the application. 

Example Ex. Hyperlink(‘www.fakeWebSite.com’, ‘click here’) returns a hyperlink that displays the text 
‘click here’.’ Clicking this text opens http://www.fakeWebSite.com. 

LoadImage:  

Description Loads a server side image based on the input path into the cell. 

Remark Can be used to load an image dynamically in place of the insert image feature. The path to the 
image must be in quotation marks. The entire path of the image is not required if your 
administrator has set a 'LoadImage' Prefix. 

Example Ex. LoadImage("c:/StarryNight.JPG")  returns  

 

file:///C:/Users/MelissaBauer/AppData/Roaming/Microsoft/Word/Documents/conditionalformattingsuppression.htm
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StripHtmlTags:  

Description Removes any html tags from the input string. 

Remark The input must be a string in between quotation marks. 

Example Ex. StripHtmlTags("<h1>This is heading 1</h1>") - returns This is heading 1. 

4 CHARTS 

Charts are a way of illustrating data to make it easy to spot trends and patterns. Most types of charts are simply a 

collection of points on a grid, with interstitial designs and labels that make them easier to read. 

By default, charts are generated dynamically, based on data points that come from Data Fields. Each data field can be 

thought of as a "series" of data, which have a common association and are connected in some way. When we put one 

data field on a chart, we have a single-series chart, which is useful for comparing values to each other. When we put 

multiple data fields on a chart, we have a multi-series chart, which is useful for comparing trends. 

Before creating a chart, make sure that your data exists in cells on the report. These cells don't have to be visible, so you 

can suppress them if desired. Charts are interactive in the Report Viewer, but will appear as static images in PDF, RTF, 

and Excel formats (CSV is incompatible). 

To insert a chart into a report, select a Group Footer or Report Footer cell and press the  Chart Wizard button. The 

Chart Wizard dialog will open. 

The Chart Wizard has four tabs: Type, Data, Appearance, Size and Preview. You can navigate between the tabs by 

clicking on the tab, or using the Previous and Next buttons. 

4.1 TYPE 

 

The Type Tab lays out all the available types of charts you can create. There are 20 types, sorted into five general 

categories. Click on a category header to see more information about that type. 
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4.1.1 Line 

Line charts display series of data points on a grid, connected by straight lines. They are often used to display a trend over 

time.  Each series on a line chart is represented as a colored line. Line charts can have up to three Y-axes. 

Variations: 

• Spline chart - Data points are connected by interpolated curves instead of straight lines. 

• Area chart - The area under each line is filled in by a color. Overlapping areas have mixed colors. 

• Spline-Area chart - A combination of a spline chart and an area chart. 

• Spark Line chart - Has no grid or axes. Use point labels and benchmark lines for reference. 

4.1.2 Bar and Column 

Bar charts use rectangular bars which extend horizontally left to right to show comparisons between categories. Column 

charts use vertical bars which extend upward. The length of a bar represents the quantity of the data value. 

Each series on a bar or column chart is represented by a colored set of bars. 

Variations:  

• Stacked bar/column chart - Series are stacked on top of each other, additively. 

• 100% Stacked bar/column chart - Series are converted to a % of the max, then stacked on top of each other, 

additively to 100%. 

• Spark column chart - Has no grid or axes. Use point labels and benchmark lines for reference. 

• Pareto chart - Combines a descending column chart, where each column is the next highest data value, and an 

overlapping line chart, where each point is the cumulative sum to that point. Often used to highlight the most 

important field in a series. Single-series only. 

4.1.3 Pie and Other Single-Series 

Pie charts are used to show the relationship of data values in a series as portions of the total. The area of each slice is 

proportional to the quantity. Each data value on a pie chart is represented by a colored "slice". Pie charts are single-

series only. 

Variations: 

• Doughnut chart - Pie charts with a hole in the center. 

• Pyramid chart - Used to show data hierarchy in addition to value. Data values are represented by vertically 

stacked slices, the height (not width) proportional to the quantity. The vertical order of the slices is determined 

by the sort order. 

• Funnel chart - Inverted pyramid chart. Often used to show retention amount, or stages in a process. Shape is 

inverted, not data order. To change the order, swap the sort direction.  

4.1.4 Scatter and Bubble 

Scatter charts use pairs of data fields with a common relation to generate coordinates as points on a grid. They are often 

used to find relationships between two variables in a set of data. Unlike most other report types, scatter charts often 

map data from detail rows, instead of group rows. 

Each series on a scatter chart is represented by a different shape and color combination. 

Variations: 
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• Bubble chart - The points become circular "bubbles", with a third coordinate field as the radius of the bubble. 

4.1.5 Combination Charts 

Combination charts are several different charts layered on top of one another. They comprise a combination of Column, 

Line, Area, and/or Stacked Column charts. (C­olumn and Stacked Column charts are not compatible with each other). 

Combination charts can have up to two Y-axes. 

4.2 DATA 
The Data Tab is used to specify which cells to use as chart data. You can change how data is translated into points by 

changing the data layout. You can also choose a sort order, as well as upper and lower boundaries for the data and axes. 

 

Add series to the chart by selecting a Data Field containing numeric values from the Series Values dropdown menu. 

Some charts may require you to select a data field to label the X-Axis. Some charts may ask for two or three data fields 

per series. The data axis is drawn automatically. 

Data is on the Y-Axis; this may not always be the vertical axis. Labels are on the X-Axis; this may not always be the 

horizontal axis. Scatter charts have no labels axis, but have X- and Y- data axes. 

Add additional series by pressing the add button.png Add Series button (disabled for single-series charts). Give a Name 

to each series. Press delete button.png to remove a series. 

Change the data layout by pressing the blue arrow button.png Data Layout... button. This will open the Data Layout 

dialog. If you change the data layout, this section will change for you to add either individual points, or groups of series, 

instead of adding individual series. See Data Layout for details. 

 

Use the Sort data by dropdown to determine how series data should be ordered: 

• Report Order – Use the sort order specified by the report. 

• Data Labels – Sort by the label axis value, alphabetically or numerically. 
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• Data Values – Sort by the value of the data. 

 

You can sort data in Ascending (A- Z, 0-9) or Descending (Z-A, 9-0) order. 

Use the Exclude values fields to ignore values that are too large and/or too small. 

• (Grid charts) Use the Data Axis Value fields to set upper and/or lower bounds for the data axis. 

• (Grid charts) Check Align Data Labels Across Series if you have multiple series with data points at common 

intervals. 

• (Pie charts) Use the Other Category Percent field to group data fields with small quantities into an "Other" 

category. 

4.2.1 Data Layout 

Your data may not fit neatly into series. This dialog accommodates different data layouts by allowing you to select from 

a couple of different ways to build a chart. 

Column Based Chart is the default. This layout builds charts by taking data fields, and mapping selected values as Y-

coordinates on the data axis. Determine which values are selected by specifying a data field with a common relation as 

the X-axis. This layout is useful if you want to plot one or more unrelated series in a group (e.g. Budget and Sales and 

Expenditures per Store). 

Use Column Based Chart if... Your report contains a group with one or more elements. 

Row Based Chart is a little more complex. This layout still uses fields as series, but all your series are a group, nested 

within another group which determines the X-axis values. Data values are mapped per series per group. This layout is 

useful if you want to plot two or more related series in a group (e.g. Sales per Employee per Store). 

If you select this layout, the data selector will change to allow you to add all your series as a group, nested within an 

outer group for the data labels. 

 

Use Row Based Chart if... Your report contains a group within a group. 

Cell Based Chart is the simplest option. This layout builds charts by taking pairs of static report values, and using them as 

(X,Y) or (label, value) coordinate pairs. 

If you select this layout, the data selector will change to allow you to add points. This layout only supports one series of 

data (duplicating data labels will create duplicate axis labels). 
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In order for the chart wizard to recognize report cells, they must be in Formula form, with a preceding = sign, text 

surrounded by quotes, and data fields surrounded by braces { }. Examples: 

Number: =42 

Text: ="February 24th" 

Data field: ={Employees.EmployeeName} 

Formula: =Month{Orders.OrderDate} 

Math: ={Orders.UnitPrice} * 2.43 

Use Cell Based Charts if... You want to build a chart point by point, and only have one data series. 

4.2.2 Appearance 

The Appearance Tab contains options for customizing how the chart will look. 

4.2.2.1 Colors 

 

Use the Colors dropdown to select a color theme to apply to the chart. Specify a custom range of colors by selecting the 

Linear Range option. 

4.2.2.2 Labels 

 

Chart Title – Enter the text you want to appear in at the top of the chart. 

(Grid charts) X-Axis Title – Enter the text you want to appear on the X-Axis (horizontal axis). 

(Grid charts) Y-Axis Title – Enter the text you want to appear on the Y-Axis (vertical axis). 

Use the Point Labels dropdown to label the points on the chart: 

• Series Values 

• Percent of Series Values 

• Data Labels 

• Data Labels with Data Values 
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Use the Legend Position dropdown to choose where to display the legend relative to the chart 

Use the Label Font dropdown to specify the font for the labels. 

Use the  Number Format... dialog to specify how data and axis labels should be formatted: 

 

 

 

(Line & combo charts) Use the  Chart Axes button to add and format axes: 

 

Press  Add Y Axis to add an additional axis. Give it a title, and use the formatting options to format the axis labels and 

data labels for associated series. Press  to remove an axis. 

Y-Axis Assignment – Use the dropdown menu for each series to associate the series with an axis. Each series will have 

the same format as the axis, and hiding an axis will hide associated series. 

Press  OK when done. 

Use the  Benchmark Lines... dialog to add horizontal lines at specific sections of the chart: 
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Press  New to add a benchmark line: 

• Label – Enter the text you want to label the line. 

• Value – Set the value for where the line will display. 

• Color –Specify the color of the line. 

• Line Style – Solid or Dashed. 

Press  to remove a benchmark line. Press   OK when done. 

4.2.2.3 Other Features 

 

To add a customization, select an attribute from the dropdown menu and press  Add Attribute. Then enter a custom 

property into the attribute field or select from the attribute dropdown menu. 

 

Press  to remove a customization. 

4.2.1 Size and Preview 

The Size and Preview Tab allows you to change the size of the chart and preview any customizations. 

Chart previews in the Wizard and on the Design Grid use placeholder data. 
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You can change the size of the chart in one of three ways: 

• Drag-and-drop the handle chart size grippy.png at the bottom-right corner. 

• Check Fit to Cell and resize the chart cell on the Design Grid. 

• Check Set specific size and enter a custom Height and Width (in px). 

5 GAUGES 

A Gauge can be displayed in a report to give a visual representation of the scale of a value. To insert a Gauge, select a 

cell and press the Insert Gauge button (). The Gauge Wizard will appear. The Gauge Wizard has two tabs: Appearance 

and Data. 

Gauges can be placed in any section of the report. 

5.1 APPEARANCE 

 

In the Appearance tab select the Type and Dimension of the Gauge. 

• Type – Select the icon representing the type of gauge. Available types include: Angular, Linear, Bulb and 

Thermometer. 

• There are three ways to set the size of the Gauge. 

o Enter the Height and Width in the dimension boxes. 

o Resize the gauge by dragging the lower right corner in the preview. 

o Check Fit to Cell. 
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5.2 DATA 

 

In the Data tab select the Data Values and Color Ranges for the Gauge. 

• Use the Value and Range dropdown to select the cell that contains the numeric value for the Gauge. 

• Use the Provide range as buttons to specify if the Min and Max values for the Gauge should be static numbers or 

come from cells on the report. 

• In the Color Ranges, use the Color By buttons to specify if color ranges should be percentages of the Max value, 

static numbers, or come from cells on the report. 

Percent Color Ranges must be in ascending numeric order. 

Use the  Add and  Remove buttons to create additional colors. To change a color, either use the dropdown () or 

enter a Hex value. 

Thermometer Gauges can only have one color. 
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6 NEW CROSSTAB WIZARD 

The New CrossTab Wizard is an interactive tool that walks you through the process of creating a new report. All of the 

settings in the New Report Wizard can be modified in the Report Designer after the report is created. 

To navigate the wizard, either click the desired tab or use the buttons at the bottom. 

 

  

The New Report Wizard has five sub tabs. The Name, Categories, and Layout tabs must be completed, while the other 

tabs are optional.  

6.1 NAME TAB 
In the Name tab, enter a report name and click on the folder where the report will be saved.  

The report name can be up to 255 characters. Avoid special characters such as  ? / \ * “ “ < >.  

A report’s description appears at the bottom of the Main Menu when it is selected. The description text is also used 

when searching for a report.  

 

Note: You cannot create a report inside a folder that is read-only (  ).  

6.2 CATEGORIES TAB 
In the Categories tab, select the Data Categories to which you would like to have access on the report. It is important to 

understand two terms: Data Category and Data Field.  

Data Category – A Data Category is a data object that has several attributes. For example, StudentDemographicCore is a 

category; each student has a studentnumber, a homeroom teacher, school building and school year, etc.  
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Data Field – A Data Field is a single attribute within a category. For example, Students.ID is the numeric value that 

identifies a specific student.   

 

• To add a Data Category, either drag and drop it to the Category Name column, use the Add button, or double-

click it.  

• To see what Data Fields are in a Data Category, click the information button ( ).  

• Check the Suppress Duplicate button to suppress duplicate information from displaying on the report. 

• To remove a Data Category, click the delete button ( ). 

6.3 FILTERS TAB 
In the Filters tab, create statements to filter the data at runtime.  

 

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or 

alphanumeric.  

• To filter a Data Field either drag and drop it to the Filter By column, use the Add button, or double-click it.  

• Use the  (up/down) and  (up/down) arrows to indicate the sort priority.  
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• To remove a sort, click the delete button ( ). 

• Set the operator (equal to, less than, one of, etc.) by selecting it from the operator drop-down list. 

• Set the filter value by either entering it manually or selecting a value from the drop-down list. If the Data Field is 

a date, the calendar and function buttons can be used to select a value.  

• Check Prompt for Value to allow the filter to be modified at the time the report is executed. 

• Select AND With Next Filter to require that the selected filter and the one below it are both true. Choose OR 

With Next Filter to require that either be true. 

• Select Group With Next Filter to indicate the precedence of the filters. 

  

6.4 LAYOUT TAB 
In the Layout tab, design the CrossTab by moving Data fields into the Row Header, Column Header, and Tabulation Data 

panels.  

 

6.5 ROW HEADERS 
Row Headers expand a CrossTab vertically. A CrossTab has a row for each unique value of a Row Header. For example, if 

you were using student data you may have the Row Header StudentDemographicCore.GradeLevel to provide rows of 

each Grade Level within a building. 

• To add a Row Header, either drag and drop it to the Row Header Source panel or use the Add Row Header 

button ( ).  

• Click the Formula Editor button ( ) to insert a formula into the Row Header.  

• Click the Edit Header button ( ) to open the header options menu. In the Header Options menu, you can: 

o Set a Label for the Row Header. This label displays at the top of the CrossTab. 

https://si.tccsa.net/Exago/NetHelp/Documents/formulaeditor.htm
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o Select a Sorting Method and direction. 

▪ None – Does not sort the Row Headers 

▪ Header Value (Text) – Sorts the Row Header by its values as though they are text. 

▪ Header Value (Number) – Sorts the Row Header by its values as though they are numbers. 

▪ Tabular Totals – Sorts the Row Header by the totals of the Tabulation Data. 

Note: If there is more than one Row Header, the Header Options Menu for the top most Row Header has Options for 

sub-totals of Tabulation Data. 

o Select where to display subtotals by using the Placement drop-down list. 

▪ None – Does not display subtotals. 

▪ Top – Displays subtotals above the Tabulation Data for each Row Header value. 

▪ Bottom – Display subtotals below the Tabulation Data for each Row Header value. 

o Set a label for the subtotals. 

• Use the  (up/down) and  (up/down) arrows to indicate the sort priority.  

• To remove a sort, click the delete button ( ). 

 

 

6.6 COLUMN HEADERS 
Column Headers expand a CrossTab horizontally. A CrossTab has a column for each unique value of a Column Header. 

For example, if you were using student data, you may have the Column Headers 

StudentDemographicCore.LocalEthnicity and StudentDemographicCore.Gender to provide columns for each gender 

count grouped by ethnicity. 

• To add a Column Header either drag and drop it to the Column Header Source panel or use the Add Column 

Header button (Use the  (up/down) and  (up/down) arrows to indicate the sort priority. ) 

• To remove a sort, click the delete button ( ). 

• Click the Formula Editor button ( ) to insert a formula into the Column Header.  

• Click the Edit Header button ( ) to open the Header Options menu. In the Header Options Menu, you can: 

o Set a Label for the Column Header to display at the top of the CrossTab. 

o Select a Sorting Method and direction. 

▪ None – Does not sort the Column Headers 

▪ Header Value (Text) – Sorts the Column Header by its values as though they are text. 

https://si.tccsa.net/Exago/NetHelp/Documents/formulaeditor.htm
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▪ Header Value (Number) – Sorts the Column Header by its values as though they are numbers.  

▪ Tabular Totals – Sorts the Column Header by the totals of the Tabulation Data. 

Note: If there is more than one Column Header, the Header Options Menu for the top most Column Header has Options 

for sub-totals of Tabulation Data. 

o Select where to display subtotals by using the Placement drop-down list. 

▪ None – Does not display subtotals. 

▪ Left – Displays subtotals to the left of the Tabulation Data for each Column Header value. 

▪ Right – Display subtotals to the right of the Tabulation Data for each Column Header value. 

• Set a label for the subtotals. 

• Use the  (up) and  (down) arrows to rearrange the order of the Column Headers. 

• To remove a Column Header, click the delete button ( ). 

         

 

6.6.1 Tabulation Data 

Tabulation Data provides information when data exists for both the Column Header and Row Header values. For 

example, if you have a Row Header on products and a Column Header on the month, then Tabulation Data of 

StudentDemographicCore.StudentNumber may use the Count function to display how students contained in each grade 

level by ethnicity and gender.  

• To add a Tabulation Data, either drag and drop it to the Tabulation Data panel or use the Add Tabulation Data 

button ( ).  

• Click the Formula Editor button ( ) to insert a formula into the Tabulation Data.  

• Click the Edit Tabulation button ( ) to open the Tabulation Options menu. In the Tabulation Options Menu, 

you can: 

o Set a Label for the Tabulation Row to display at the beginning of each row. 

o Use the Method drop-down list to select the summary function to be applied to the Tabulation Data.  

▪ Sum: Totals the Tabulation Data. 
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▪ Count: Counts the Tabulation Data. 

▪ Average: Take the mean of the Tabulation Data. 

▪ Minimum: Displays the lowest value in the Tabulation Data. 

▪ Maximum: Displays the highest value in the Tabulation Data.  

▪ None: Displays the value of the Tabulation Data without applying any formula. 

o Use the Value drop-down list to select how the Tabulation Data should be displayed. 

▪ Aggregate: Display the result of the selected Method. 

▪ Percent of Row: Display the result of the selected method as a percentage of the row total. 

▪ Percent of Colum: Display the result of the selected method as a percentage of the column total. 

• Use the  (up/down) and  (up/down) arrows to indicate the sort priority. 

• To remove a sort, click the delete button ( ). 

 

 

6.7 CROSSTAB OPTIONS 
Settings that affect the entire CrossTab are controlled in the CrossTab Options Menu. Open the CrossTab Options Menu 

by clicking the Options button ( ). Using this menu, you can adjust the following settings: 

6.7.1 General  

• Use the Row Headers Placement drop-down list to determine how the Row Headers are displayed. 

o Columns – Display the Row Headers in columns from left to right in the order they are in the Row 

Header Source panel. 

o Hierarchical – Display Row Headers in a hierarchical structure using indentation to display their order. 

• Check Repeat CrossTab Header every new page to repeat Row Header labels and Column Headers on each new 

page.  

6.7.2 Grand Total Row 

• To get a total for each column, select Top or Bottom from the Placement drop-down list in the Grand Total Row 

section and provide a label in the Label text box.  
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6.7.3 Grand Total Column 

• To get a total for each row, select Top or Bottom from the Placement drop-down list in the Grand Total Column 

section and provide a label in the Label text box.  

 

6.7.4 Preview 

At the bottom of the Layout tab, a preview shows how the Crosstab displays based on the fields that have been 

added.  You can increase the size of the preview by dragging up and down in the area between theme drop down and 

the preview box 

 

6.7.5 Final Report Design 
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7 TRAINING WORKSHOP DEMO 

7.1 DEMO 1: STANDARD REPORT WITH GROUPING AND REPEATING GROUPS 
The high school principal desires a mark breakdown by teacher for each class and the total count students for each mark 

in the classes that are taught. Create a report that filters by reporting term for a specific school and school year along 

with student grade level and status. Your Final Result will look like the following report.  

 

Hints: 

• Use Group Header and Footer 

• Use Repeating Group 

• Use AggSum formula 

• Use If Formula 

• Use Concatenate Formulas 

  


